Exercise 7b – Woodlark Basin Regional Topography, Bathymetry, Volcanism and Seismicity 

Data sets (downloaded in Exercise 7a):
· SRTM DEMs from CGIAR

· high resolution bathy DEM of the Woodlark Basin region

· earthquake data from USGS Earthquake Hazard Program

· world volcano data from the Smithsonian Global Volcanism Program 

· continents shapefile from ESRI

· etopo1 bathy/topo DEM from NGDC/NOAA

· Wood_vectors and Wood_ages jpegs
Due: Friday, March 5 at the start of class.
Goal: to combine several DEM data sets to make a composite topographic/bathymetric view of the area and to add data on earthquakes and volcanoes in preparation for an analysis of the correlations among the data sets.
Turn in: post 1) an ArcMap jpeg that clearly illustrates the topography, bathymetry, and active volcanoes of the region, and 2) an ArcScene jpeg that shows the 3D distribution of earthquakes. Be sure that your ArcMap has all the required elements of a high quality ArcMap. The ArcScene doesn’t need labels, etc.
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The world map of plates above shows a network of small plates in the Southwest Pacific that are involved in the interactions among the much larger Pacific, Australian, and Eurasian Plates. We’re going to focus on the area near a small (but very interesting!!) basin called the Woodlark Basin.
Notice on the map on the previous page that the Australian Plate is shown extending to the NE all the way to a festoon of convergent plate boundaries that lie south of the Bismarck Plate and southwest of the enormous Ontong Java Plateau. 

A view of the bathymetry in Google Earth (below), however, shows some odd bathymetry in the Solomon Sea, the Woodlark Basin, and the northern Coral Sea between Australia and the New Britain/Solomon Islands area. We’ll use a variety of geological, geophysical, and topographic/bathymetric data sets in ArcMap to evaluate whether the plate interactions are more complicated than shown in the map on the previous page. 
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New techniques in this exercise:

· making a hillshade from an unprojected raster (one with just a GCS) using the Z factor.

· clipping both a raster and a shapefile using a polygon drawn to specific lat/lon coordinates.

· adding X-Y data to ArcMap from an Excel spreadsheet.

· customizing color ramp symbology and dealing with symboizing a very large data set.

· portraying a 3D data set in ArcScene for visualization.

· georeferencing a map that has no spatial reference.

Part I. Clipping your etopo1 DEM to the right size

Your etopo1 DEM is a worldwide bathy/topo DEM, and it’s a big file. You’ll start by clipping the DEM to the same size as your SRTM DEM.

A. Making a shapefile to use for clipping

1. In ArcCatalog, rt-click on the folder where you want to save the shapefile. 
a. New > Shapefile.
b. Choose polygon. Set the coordinate system to GCS > WGS84.

2. Launch a new ArcMap, and add the etopo1 DEM and your new shapefile. You will draw a polygon between 0 and 15S latitude and 145E to 160 E longitude. It’s easiest if you can see all of these corner points before you start drawing your polygon. Zoom in to this approximate area. 

3. Turn on the Editor toolbar, if it is not already on.

a. Pull down the Editor menu > Options > Units. Set to Polar and Decimal Degrees.
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b. Start Editing, and choose your new shapefile.

c. Make sure that the Editor pulldowns are set to Create new feature and that the layer you’re about to work on is your new shapefile.

d. Choose the pencil tool, and move the pencil tool onto the map. The icon will change to a blue circle with crosshairs. Rt-click once on the map (it helps to be near the location where the first vertex will be), and scroll to Absolute X, Y. 
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e. The first corner that you will enter is the NW corner, which has the coordinates 145 E, 0 S. Notice that you have to enter X first (that’s longitude) and then latitude (which is Y). Press the Enter key, and the cursor will jump to the first vertex.

f. Move the cursor, rt-click again, choose Absolute X, Y, and enter the coordinates for the NE corner of the box. Repeat for the SE corner and the SW corner. This creates three sides of the box. 

g. Right click, and choose complete the sketch. The polygon completes with all four sides.
h. Stop editing and save edits. You now have a shape file with vertices at the specific lat/lon coordinates of your SRTM DEM.

B. Clipping your etopo1 DEM

1. Locate the Clip tool under the Raster Processing tool in ArcToolbox. Input your etopo1 file.

2.  Add your new polygon shape file as the Output Extent, and be sure to check Use Input Features for Clipping Geometry.

3. Name your new clipped raster, and click OK. Add to the ArcMap.

4. Delete the unclipped version of the raster from your ArcMap TOC. Save.

Part II. Making hillshades from the various DEM data sets

Before making a hillshade in previous exercises, you projected a raster from GCS to PCS in order to have the X, Y, and Z units all in meters. In this current exercise, all of the data are in a GCS (namely WGS84), and for what we’re going to be doing, we’d like to be able to leave everything in WGS84. Fortunately, there’s a way to make a hillshade without projecting the data.

A. Z factor

1. Here’s what ArcMap 9.3 Help says at http://webhelp.esri.com/arcgisdesktop/9.3/index.cfm?id=6064&pid=6057&topicname=Applying_a_z-factor 
a. The z-factor is a conversion factor that adjusts the units of measure for the vertical (or elevation) units when they are different from the horizontal coordinate (x,y) units of the input surface. It is the number of ground x,y units in one surface z unit. If the vertical units are not corrected to the horizontal units, the results of surface tools will not be correct.

b. The z-values of the input surface are multiplied by the z-factor when calculating the output surface. If the x-, y-, and z-units are all the same (in feet, for example), the z-factor is 1. This is the default value for the z-factor. For another example, if your vertical z-units are feet and your horizontal x,y units are meters, you would use a z-factor of 0.3048 to convert your z-units from feet to meters (1 foot = 0.3048 meter).

c. The correct use of the z-factor is particularly important when the input raster is in a spherical coordinate system, such as decimal degrees. It is not uncommon to perceive the output from Hillshade to look peculiar if the input surface raster is not in a projected coordinate system. This is due to the difference in measure between the horizontal ground units and the elevation z-units. Since the length of a degree of longitude changes with latitude, you will need to specify an appropriate z-factor for that latitude.
2. So, what does this mean for hillshades of DEMs? In our DEMs, the X and Y coordinates are specified in decimal degrees, and the elevations are in meters. 

3. So, we need to provide ArcMap with a Z factor to use to convert our elevation values in meters to decimal degrees so that the X, Y, and Z units are all in decimal degrees.

4. We can figure this out. At the equator, the circumference of the Earth is 40,075 km.

a. How many kilometers are there in one degree of longitude at the equator? Show how you figured this out.

b. How many meters are there in one degree of longitude at the equator? Show how you figured this out.

c. How many degrees are there in one meter at the equator? Show how you figured this out.

d. This last number is the Z factor, i.e., the conversion factor that ArcMap needs in order to properly do a hillshade of a DEM that is in a GCS. Multiplying an elevation in meters by the Z factor will give an elevation in decimal degrees.

5. Z factor is latitude-dependent, and what we’ve just calculated is the Z factor at the equator. On the last page of this exercise, you’ll find a table where you can look up the Z factor for a given latitude. You’ll see that the number for a latitude of 0° is exactly what you calculated.

B. Hillshades of your DEMs

1. You’re going to work in ArcCatalog so that you can easily preview and delete trials if they don’t work out.

2. Launch ArcCatalog > Arc Toolbox > Spatial Analyst > Surface > Hillshade. 

3. You should have three raster DEMs: the clipped etopo1, the mosaicked SRTM, and the Woodlark DEM. Check the metadata for each one to make sure that each has a GCS, not a PCS.

4. Make and save a hillshade of each of your three DEMs, being sure to use the correct Z factor.

5. Preview each hillshade in ArcCatalog, and be sure to OK building pyramids. Zoom in and check to make sure that your hillshades look good. If they don’t, troubleshoot the reason, delete the offending files, and try again.

Part III. Making an ArcMap base map using your DEMs and hillshades
A. Adding DEMs and hillshades

1. Add your DEMs and hillshades to the ArcMap that already contains your clipped etopo1 file. 
2. Arrange the order so that the etopo file and its hillshade are on the bottom, with the SRTM DEM and its hillshade in the middle, and the Woodlark DEM and its hillshade at the top. 

B. Colorizing the layers
1. Colorizing your SRTM land layer
a. Make the hillshade partially transparent using the Display tab in Properties. Use the settings Contrast = 30; Brightness = 5; Transparency = 50. This gives a bit more brightness and color saturation to an underlying colorized DEM.

b. Colorize the DEM using a color ramp that looks like land. You can always change this later and experiment around with various color ramps.

2. Colorizing your Woodlark DEM bathy layer
a. Make your hillshade partially transparent using the same settings as for the land layer.

b. Colorize the DEM using the Spectrum Full Bright color ramp (remember you can see the names of the color ramps by rt-clicking on the color bar and selecting Graphic View). Click Invert to make blue the bottom color.

3. Colorizing your etopo1 bathy/topo layer
a. Make the hillshade partially transparent as before.

b. Colorize your DEM using the same color ramp as you used for the Woodlark layer.

c. Oh no! It doesn’t quite match the Woodlark layer! Why not? If you turn off the two SRTM layers, you’ll see that the etopo1 layer also includes elevations above sea level, whereas the Woodlark DEM does not, and the minimum elevations don’t match. That means that the color ramp is stretched out over different elevation ranges in the two DEMs.

d. We can fix that by customizing the color ramp stretch. 

e. First, you’ll need to check to see what the maximum and minimum elevations are in the Woodlark DEM (it’s right there in the TOC). Write them down here:

f. Go back to symbology for the etopo1 DEM, and scroll down to the Statistics box. Chose From Custom Settings (below). Set the min and max values to match the min and max values in the Woodlark DEM, making sure to use a negative number for elevations below sea level. 

g. Click OK. The color ramps should now merge seamlessly! Any differences are a function of the resolution differences in the two DEMs.

4. Now that you’ve seen how this works, you can experiment with other color ramps. Just be sure that, in the color ramp you choose, it’s easy to see where the shoreline is (i.e., don’t pick color ramps where the bathy and the topo merge together at the shoreline) and that it’s clear where the deep and shallow water is. Note that you can layer the hillshade and DEM in reverse order and make the colorized DEM the partially transparent one.
Part IV. Adding your volcanoes and earthquake data
A. Adding your volcanoes file and clipping it to size

1. Add your world volcanoes Excel file to your ArcMap (if there is more than one sheet, add sheet #1). The TOC automatically switches to Source view, because ArcMap cannot display an Excel file. You now need to add the data to the map. 

2. Rt-click on the Excel spreadsheet icon that you added, and select Display X-Y data. **Be sure that X is set to the Longitude (LON) field and Y is set to the Latitude (LAT) field. If they aren’t, use the pulldowns to choose the correct fields. Choose a Coordinate System to match all your other data sets. Click OK.

3. You’ll get a warning box that tells you that the table does not have an Object-ID field. This is OK, because you’ll export it in the next step to create a shapefile. Click OK.

4. You will now have an events layer in the TOC. Rt-click on the icon in the Events layer > Data > Export to create a shapefile. Save it with a meaningful name. 

5. Delete the Events layer and the Excel spreadsheet from your ArcMap, and switch back to Display view.

6. Your volcanoes shapefile is another worldwide data set (choose Zoom to layer to see the whole thing). Use your polygon shapefile to clip your volcanoes shapefile, and add the layer to the map.

7. Delete the world volcanoes layer from your ArcMap, and rearrange layers if necessary so that the clipped volcanoes lies above all of the other layers. Open the attribute table to see what’s there.
8. Browse around a bit, and admire the morphology of the volcanoes on the hillshade layer!!!
B. Adding your earthquakes

1. Repeat the steps in IV-A-1 through 5 above for your earthquakes spreadsheet.

2. If you originally selected the correct rectangular area when you downloaded the data, you won’t need to clip the resulting shapefile. If you blundered, then clip your earthquake data to match the DEM outline.

3. Open the attribute table to see what’s there. How many earthquakes you have in your data set? Write it down here:

4. Symbolizing by depth or magnitude

a. Go to Symbology > Quantities. You can symbolize by any of the fields in the attribute table, but we’ll do an example with Depth.

b. Choose Depth in the Value pulldown. You‘ll get a warning that you’ve reached the maximum sample size, so you’ll need to change the maximum sample size.

c. OK the warning box, and click on Classify > Sampling and type in a maximum sample size that is larger than the number of earthquakes you have. That way, ArcMap will symbolize your whole data set. Click OK.

d. While you’re at it, change the Break values to more logical increments. In order to emphasize differences among shallow quakes, try five increments at 30, 70, 100, 300, and 500. You can always change this later. Click OK. 

e. Click on the Label header in the box under the color ramp bar, and select Format Labels. Choose Number, and set the number of decimal places to 0. Click OK.

f. Choose your color ramp. If you want to reverse the color ramp that you’ve chosen, click on Symbol, and select Flip Symbols. Click OK.

C. You can now experiment with coloring or symbolizing your earthquake and volcano data based on various parameters in the attribute table.

Part V. Georeferencing some additional geophysical data
What if you have a paper or digital map that has great information but that is not spatially referenced? Not to worry! It’s possible to use ArcMap to georeference a map and assign coordinates to spots of known location on the map so that ArcMap can place it in coordinate space.

You will take two data sets that are pulled from a figure in a paper by Dr. Suzanne Baldwin of Syracuse University (Baldwin et al., 2008), georeference them, and add them to your ArcMap. Start by going to the Data folder on the MSS and downloading the two jpeg files, Wood_ages and Wood_vectors.
A. Ages of oceanic crust in the Woodlark Basin
1. In ArcCatalog, preview the Wood_ages jpeg. This is simply a jpeg of a portion of one of Suzanne’s illustrations, and it shows ages of oceanic crust in the Woodlark Basin. Although it looks like a shapefile, it’s not. It’s a raster that is simply a scan of a map.

a. Dark gray = <2 Ma

b. Medium gray = 2-4 Ma

c. Light gray = >4 Ma
2. Make a copy of your Wood_ages jpeg so that you’ll have an original to go back to if you blunder. 

3. Georeferencing the jpeg

a. Start a New ArcMap, and set the coordinate system of the DataFrame to WGS84 (GCS, not PCS). Add the Wood_ages jpeg. You’ll get a warning dialog box that the file has no spatial reference. That’s OK, because you’re going to add one by georeferencing the file. Drag the file to the top of the TOC list.

b. Add the Georeferencing Toolbar. **Make sure that the target layer in the pulldown is your Wood_ages jpeg, and select Fit to Display from the Georeferencing pulldown menu. Your Wood_ages jpeg will now fit inside the ArcMap window.

c. Click on the View Link Table icon in the Georeferencing toolbar (see picture on previous page), and then click on the Add Control Points icon (the one with the two Xs connected with a line). Center the cursor cross exactly on one of the corners of the figure where the lat and lon is known. Left click to set the cursor, and then right click. 
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d. Select Input XY. In the Enter Coordinates box, type in the lon and lat of the corner point, being sure to put the lon in the first box and using a negative number for south latitude. Press Enter.
e. Center the cursor over a second corner, left click to set the cursor, right click to bring up the XY box, and enter the next lon/lat coordinate points.

f. Repeat for the remaining two corners of the map. If you blunder and enter a bad point, go to the table, highlight the offending row, and delete with the X button to the right of the table.
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g. When you are done with the four corners, check the table of residuals – you should have a very low residual (something like .003 or .0003). If you have a large residual, delete all of the rows, and try again.

h. Go to the Georeferencing pulldown menu, and select Update Georeferencing. This process adds a World File to the jpeg (it’s one of those auxiliary files that shows up when you look at files such as this in Windows Explorer). As long as this world file stays with the jpeg, it will be georeferenced, and ArcMap will know where to put it on any map.

4. Getting rid of the white background and the map border
a. Clip the raster to get rid of the map border and lats/lons. Save. 
b. Add the new clipped file to your ArcMap.

c. Put a check mark in the Display Background Value, and type 255 into each of the three boxes (RGB). Then, select No Color from the little pulldown to the right. This will take all the white (color 255) and make it No color.

B. Plate motion vectors in the Woodlark Basin area

1. In ArcCatalog, preview the Wood_vectors.tif. This is another portion of one of Suzanne’s illustrations, and it shows present-day plate motion vectors with respect to an arbitrarily fixed Australian Plate. As with the ages file, this is not a shapefile; it’s a raster. Make a copy to work on so that you can recover if you screw up.

2. Add Wood_vectors.tif to the temporary ArcMap that you created in step 3A above, rather than adding it to your Woodlark ArcMap. In the georeferencing menu, select the Wood_vectors file in the target pulldown before choosing Fit to Display and proceeding with georeferencing.

3. Clip the raster to size as you did for the Wood_ages jpeg. Save.

4. Add the clipped file to your Woodlark Basin ArcMap, and delete the unclipped one from your ArcMap.
5. Go to Symbology > Classified, and OK calculating histogram, if it asks. Change the white to No color.

Part VI. Your earthquakes in ArcScene
Your earthquakes are hard to visualize in 3D on your ArcMap, because there are so many of them that they cover up things that you’d prefer to be able to see. Viewing them in ArcScene will help!

A. Adding a base map and your earthquakes to ArcScene

1. In ArcCatalog, clip your old friend the continents shapefile to match the outline of your main DEMs. Be sure that you’re working with a version that has only a GSS (WGS84), not with one of your projected versions.

2. Choose View > Toolbars > 3D View  Tools. Click on the ArcScene icon to launch ArcScene.

3. Add your clipped continents shapefile, and increase the transparency of the continents.

4. Add your earthquake shapefile.

B. Plotting the earthquakes at the correct depth in 3D

1. Right now, all of your earthquakes are plotted as if they were surface quakes. We’d like them to plot at their correct focal depths.

2. Select the Base Heights tab from the Properties window for your earthquakes layer.

b. In order to plot the earthquakes at their correct depths, we need to use the equivalent of the Z factor that we used earlier.

c. In this data set (which is in WGS84), X and Y are in decimal degrees, but Z (the earthquake focal depth) is not only in kilometers, but the numbers are all positive numbers (whereas bathymetric depth below sea level is always expressed with negative numbers).

d. So, start out by figuring out what factor you will have to multiply kilometers by in order to get decimal degrees (see section II-A if you’ve forgotten how to figure this out):

e. In the Base Heights box, highlight the radio button Use constant value or expression to set heights for the layer. Click the calculator icon. Double-click on Depth in the Fields box, then single click on *, and type in the factor that you have calculated with a minus symbol because the depths are below sea level. The formula should look something like this:

[Depth]*-.00X

with “X” being your calculated factor

f. So, what does this formula do? It multiplies each earthquake depth by a factor to convert from kilometers to decimal degrees, changes the sign of the number so that it will plot below sea level, and tells ArcScene to plot each quake at that height in your ArcScene.

g. Click OK. If it doesn’t look pretty swell, you’ve blundered on the Z factor.

3. You can also use Symbology to the colorize or symbolize the quakes.

B. Adding a 3D hillshade

1. You can also add your etopo1 hillshades.

2. To plot the base heights at the correct elevations, select the Base Heights tab from the Properties window for your hillshades layer. Select Obtain heights for layer from surface, and choose your etopo1 DEM (the original DEM is the file that has the elevations you need). Remember that you need a Z-factor! Which Z factor should you use, the one you calculated in II-A, or the one you calculated in VI-B for earthquake depth? Why?

3. Type in the correct Z factor, and click OK. You’ll know immediately if you made the wrong choice…..

What’s due on Friday:

Post two jpegs in the Shared folder before the start of class on Friday:

· An ArcMap that shows everything except the earthquakes, the ages, and the motion vectors.

· Be sure to include all of the elements of a high quality ArcMap, including: scale, legend, title, north arrow, your name, date, map projection, inset key map, data source, lat/lons, and any necessary captions and labels).

· Work on the design elements of your map, and be conscious of layout, adequate white space, use of color, legibility, and graphic hierarchy.

· An ArcScene view that shows the 3D distribution of earthquakes. You don’t need to have any annotation, just a jpeg of the graphic.

Variation of Z factor with latitude

From the ESRI ArcMap Web Help at:

http://webhelp.esri.com/arcgisdesktop/9.3/index.cfm?id=6064&pid=6057&topicname=Applying_a_z-factor 
If your x,y units are decimal degrees and your z units are meters, some appropriate z-factors for particular latitudes are:

    Latitude      Z-factor

     0          0.00000898

    10          0.00000912

    20          0.00000956

    30          0.00001036

    40          0.00001171

    50          0.00001395

    60          0.00001792

    70          0.00002619

    80          0.00005156

Note that as the range of latitude in your raster data increases, the more approximate the results will be.

� 	Thanks to Dr. Andrew Goodliffe, University of Alabama, for the high resolution bathymetry of the Woodlark Basins for this exercise. Map above from � HYPERLINK "http://denali.gsfc.nasa.gov/dtam/data/ftp/gtam.gif" ��http://denali.gsfc.nasa.gov/dtam/data/ftp/gtam.gif�


	map above from http://denali.gsfc.nasa.gov/dtam/gtam/
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